Online Billing

00U,




For any assistance please contact TNT VN Credit Department
Email: einvoicing.admin.vn@tnt.com
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welcome

to Online Billing with TNT

\\_

Administration can be a time-consuming process.

When you’ve got a hundred and one things to do, the last thing
you need is a pile of paperwork to record and file.

Speed and simplicity is what you need.

So to make life easy, we’ve developed an electronic
administration system that enables you to administrate all your
accounts — invoices, credits, statements and payments — in just
a few clicks.

It’s smart, it’s fast and green too. Nothing could be simpler.

This guide tells you all you need to know about using TNT’s
Online Billing system — the more efficient way of managing your
accounts.
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Vietnam [change] larger text print page other sites stemap ~ contact us

SHIPPING TOOLS SUPPORT ABOUT US

Send package
Send Package B28 only

That's why you now get

lower rates.

Day Definite delivery at even

From Vietnam

To Please select

=]
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New Gustomers - How to

send a package

Track shipment status
Create shipping documents
Pack and Label

Contact us

T

elpful Links

= Non-Electronic Consignment
(NEG) Surcharge

Out of Area Surcharge
Import Handling Surcharge
Storage and Return fee
Volumetric weight calculation

terms of use privacy policy terms &

itic

Shipping updates

= Security Update
= Fuel Surcharge
International Service Alerts
Customs & Shipping Updates

Manage all your shipping and
tracking needs in one place.
Includes: Fast shipping
View shipping history
Advanced tracking
Address book

Find out more about myTNT

= Export Controls and Sanctions
News

TNTExpress extends 'before 12:00°
delivery coverage in Europe

- ‘Before 12:00' coverage extended to
900 additional locations across 16
European countries. + Extension benefits
exporter and importer customers who
require guaranteed moming deliveries
for documents, packages and freight

Intellectual and other property rights to the information contained in this site are held by TNT Holdings B.V. with all rights reserved @ 2011
——

Customer Service Hotline: 1800 1589

[P

TRACK PACKAGE

Enter your consignment number or
reference to track your package:

Consignment®  Reference(™

| [ search

Track

©

Multiple Packages

Need help? - Please call 1800 1589

or contact us for your details.

Log in to your account
login
login password

save details|

Forgotten your password? | All
about myTNT

000

SERVICES

Home / Terms and conditions

> Services
> Shipping Tools
> Support
> About Us

Vietnam [change] larger text printpage  other sites stemap  contact us

SHIPPING TOOLS SUPPORT  ABOUT US

TNT EXPRESS TERMS AND CONDITIONS OF CARRIAGE AND OTHER SERVICES

LONG FORM VERSION 01-2012 - ENHANCED LIABILITY

1. DEFINITIONS

The following definitions apply to the terms and conditions set out below that govern the
contract of carriage and other services beteen you and us.

"We", "us" "our" and TNT means TNT Express Worldwide N.V. and its group companies (“TNT")
and TNT's employees. agents and independent contractors;

"you" and *your" means the sender or consignor.

“carriage” means and includes the whole of the operations and services undertaken by us in
connection with the transportation of the shipment;

“other services” means all services not being services for the carriage of shipments that are
performed by us, including, but not imited to, storage, sorting. kitting. merging, packing,

instaliation. value added: and services,

Customer Service Hotline: 1800 1589

o [searen ]

QUICK LINKS

Check price
Check transit times

Track package

Log into myTNT

Check TNT fuel surcharges
e-Invoicing

vivivivivy

Registering for Online Billing with TNT

1. Registration information

TNT Terms and Conditions of Carriage

is quick and easy.

Please contact TNT Administration
Department to provide registration
information for Online Billing.

Email address: einvoicing.admin.vn@tnt.com

or call (848) 3 848 6822.

Please mail to us following details to create
your login to Online Billing with TNT, and the
information given will be used to verify that
you are the owner of the account:

Your language (ex. English, Vietnamese)
Your TNT account number

Your Full name

Your Mobile phone number

Your Office phone number

Your Email address

You accept our TNT Terms & Conditions
of Carriage and other services

N R ®WNE

Our TNT Terms and Conditions of Carriage
and other services is available on the TNT
internet site:

http://www.tnt.com/express/en_vn/site/home.html
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for Online Billing with TNT

From: no-reph@tnt. com
To: Account Payable@compsni.com

Dat=: O6/10,2014 07:47 PM

Subject: Automatic Registration for TNT Financial Tools - Account Pavablei@company. com

Dear Ms. Sarah Green,

wWelcome to Online billing.
Your account is ready to use.

Your user-id is: Account Payable@company .com
Your password is: yvaNWzLGUDB’Wk
Youwr login page is:

The registration details are:

Company MNMame: X%Z Compary

Contact Name: Sarah Green

Company MName: Wi

Contact Email Address: Account Payable@company corm
Contact Email Address: Account Payable&@company com
Accoount Number: 000012345

Preferred Email Language: ERN

For further information please visit htipJYwww. int.comy or call to TNT WK Credit Department
Kind Regards,
THNT Express

TNT sure we can

This e-mail was automatically generated. Pleass do not reply to this e-mail.

THNT accepts no liability for the content of this email. or for the consseguences of any actions taken on the
basis of the information provided. unless that information is subsequently confirmed in writing. If you are
not the intended recipient you are notified that disclosing, copying. distributing or taking any action in
refliances on the contents of this information is sirictly prohibited.

${country} | change | larger text prnt page other sttes  stemap contact us
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et password for a user

Reset password
Fields marked with * are required

3 sorry. We are not able to process your request.
The password needs to be changed. Please follow the password reset procedure.

Username” Account payable@Company. Com

(“Caneer il Coniim <=t

tenns ol use  privacy policy  Lerms & conditions
Intellectual and other property rights to the information contained in this site are held by TNT Holdings B.V. with all rights reserved © 2011
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${country} [change ] larger text print page other sites ~ sitema] contact us

SERVICES ~ SHIPPING TOOLS ~ SUPPORT  ABOUT US ‘ = ” search ‘

Home / Reset password for a user

Reset password
Email has been sent to you. Please follow the instructions in the email to reset your password.

Back to home page

terms of use privacy policy terms & conditions
Intellectual and other property rights to the information contained in this site are held by TNT Holdings B.V. with all rights reserved © 2011

2. Activate your registration Confirm to reset your password
After your account information is verified by Then, you are required to confirm the reset
our Administration Department, you will password by clicking the “Confirm reset”
receive an email shortly to activate your login button.
detz:nls. Slmply click the link wnhm the email You will then be notified that “Email has
you've received. Enter your login name and been sent to you. Please follow the password

password to activate your registration. procedure”
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for Online Billing with TNT

Dear Ms. Sarah Green,
Pleass click on the following link to reset the password.

http “Ycommon.tnt.com/ffinance-login/resetpasswordconfirmation. hitml #ticket=MTAwMDAwWNz MOODA4Zlo
cale=an_WVN

If the link is not clickable, please copy and paste the URL above into the address field of your intermet
browser.

This link to reset password is valid for 24 hours after it was sent.

For further information please visit httpzwww . tnt.com/ or contact TNT VN Credit Department
Kind Regards,
THNT Express

TNT sure we can

This e-mail was automatically generated, Please do not reply to this e-mail.

TNT accepts no liability for the content of this email, or for the consequences of any actions taken on the
basis of the information provided, unless that information is subsequently confirmed in writing. If you are
not the intended recipient you are notified that disclosing., copying, distributing or taking any action in
reliance on the contents of this information is strictly prohibited.

S{country} [change ] largertext printpage  othersites stemap contact us

Siks SERVICES SHIPPING TOOLS SUPPORT ABOUT Us 2 |[ search |
/_a”'

Home / Reset password

Reset password

Fields marked with * are required

u Account P: ompany.Com

New password” esesssses View password criteria

Re-enter new password” esesesess

amcer ll— Contimreser ]

${country} [change ] larger text print page other sites  sitemap contact us

i i i SERVICES SHIPPING TOOLS ~ SUPPORT ABOUT US |p H Search ‘
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Home / Reset password

Reset password

Thank you. You have reset your p:

Back to home page

terms of use privacy policy terms & conditions
Intellectual and other property rights to the information contained in this site are held by TNT Holdings B V. with all rights reserved © 2011

4. Reset your password

Simply click the link within the email you've Enter your login name and your new After new password is successfully changed,
received, within 24 hours after receipt of the password, then confirm. Your new password You have now successfully registered for
email. must contain alpha and numeric characters TNT’s Online Billing.

and must be at least six characters long.

S—
From: no-rephy @tnt.com
To: Account Payable@company .com
Date: 06/M12/2014 12:59 PM
Subject: Activation Link To Reset Password
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TNT’s Online Billing system makes the laborious task of
processing invoices and reconciling statements so much
easier.

In just a few clicks you can access all your account information
without having to waste time searching for invoices in filing
cabinets or filling in data manually.

v'Receive your Debit notes online
v'Get email alerts as new invoices issue

v'Download Debit notes and statements as pdf or excel
spreadsheets

v"Access invoicing data and statements 24/7/365

v'Raise and track the progress of your invoice disputes

/—
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to Online Billing with TNT

S${country} [change ] larger text print page other sites  stema contact us

SERVICES SHIPPING TOOLS SUPPORT ABOUT US
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Home / Finance login

Login to Online Billing

Login to manage your invoices online

Select your location® | Vietnam / English =]

Username Account Payable@Company.com
Password IIII!'...l

[tosi
Forgot password?

terms of use privacy policy terms & conditions
Intellectual and other property rights to the information contained in this site are held by TNT Holdings B.V. with all rights reserved ©® 2011

B ==

There are a number of ways you can enter

the Online Billing site. Or when we notify you that an invoice has
been posted to your account, you can click
on the

You can log on to www.tnt.com, select www.express.tnt.com/onlinebilling/login link

Online Billing from the Shipping Tools drop in the email.

down menu and login to Online Billing.

Then simply enter your login name and
You can go directly to password and click the login button.
www.express.tnt.com/onlinebilling/login.

If you forget your login name or password
simply click on ‘Forgotten login/password

and we’'ll send it to your email address (if this
is your login name) and your notification
address.

If we don’t have your email address we’ll
send it to your company’s registered user
group.
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SERVICES SHIPFING TOOLS SUFFORT ABOUT US |p || search |

Home / Finance login / Landing page

Online Billing

Welcome to Online Billing, where you can manage and pay your invoices online.

ePayment - You can pay and dispute your invoices.
elnvoicing - View, Download and Print your invoices.

Account Set-up - Maintain the THT accounts you can access
Password Maintenance - Change your password or cancel your registration.

Log Out

terms of use privacy statement terms & conditions  TNT Global
Intellectual and other property rights to the information contained in thiz site are held by TNT Holding B.\. with all rights reserved ® 2008

Once you’ve logged in, you enter the Online
Billing landing page.

By clicking ePayment you can view your
account statement or raise and track the
progress of an invoice dispute.

By clicking elnvoicing you can view all your
invoices and credit notes from the last 26
weeks in several common formats.
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Language Selection eInvcicing FOF Cocument
CSV Data File
Documents XLS Data File
> Hew Documents lew Documents XML Data File
> All Documents / \
Account Humber Invoice Number  Invoice Date Doc Type Amount Due Date iew \
» Change Username o e | | | ‘ ‘A” b o = ﬂ
> Email Addresses D BE:000003648 10086885 28/05/2013 (Wk22) Invoice 0,00 EUR 5/06/20 D D D D
> Add Account [] BE:000003649 10094433 S/08/2013 (Wk23)  Invoice 0,00 EUR 12/06/2 B B B H
Hep [ BE:000003849 10058044 /0572013 (Wk18)  Invoice 0,00 EUR 80572013 ] B B B B
» Customer Portal User Guide
+ et Adobe Reader [ BE:000003649 10085461 8I05/2013 (WK19)  Invoice 0,00EUR 15/05/2013 L
Logout [ BE:000003649 10072527 15/05/2013 (Wk20) Invoice 0,00 EUR 220502013, O
> Logout [] BE:000003649 10079391 22/05(2013 (Wk21) Invoice 0,00 EUR [ O .
[ BE:000003648 10028385 300412013 (Wk14)  Invoice 10/04/2013 O0Ooo
[] BE:000003645 10035821 10/04/2013 (Wk15) Invoice 0,00 EUR 17/04/2013 F F E H
[] BE:000003643 10043011 17/04/2013 (WK16)  Invoics 0,00 EUR 24/04/2013 FE B B
[] BE:000003649 10050591 24/0412013 (WK1 Mvoice 0,00 EUR 170572013 B B B H
[ BE:000003849 09997894 Invoice 0,00 EUR 13/03/2013 FE A B
[ BE:000003649 10005753 %103/2013 (Wk11) Invoice 0,00EUR 20/03/2013 O L
[ BE:000003649 20/03(2013 (Wk12) Invoice 0,00 EUR 27/03i2013 B B ®H
[ BE:000003648 27/03(2013 (Wk13) Invoice 0,00EUR 3/04/2013 [ O .
[] BE:00000364g, 09960527 30/01/2013 (WS} Invoice 0,00 EUR 60212013 OO OO
.l 09967943 £i02/2013 (WK} __Invoice 0,00 FUR _13/02/2013 [0 1 1 1 s
Viewing
Once you've selected elnvoicing after logging * A data file (CSV, XLS or XML). This can be If you want to download a number of
in, a list of your new invoices and credit imported directly into your accounting different invoices (up to a maximum of ten),
notes will automatically be displayed. You software. simply select the file formats you need, click
can view these as: ‘Download Selected’ and this will create a zip
To view the file in the format you want, file.
* A PDF. This is a soft copy of the actual simply click on the corresponding icon
invoice that contains exactly the same displayed in the key. Once an invoice has been downloaded or
information as your original invoice and can viewed the file will automatically be moved

be printed, emailed or faxed. to the ‘All Documents’ section of the site.
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elnvoicing
Language Selection

Documents
> Hew Documents Hew Documents
> All Documents

Preferences

POF Document

CSV Data File

XLS Data File

XML Data File

Remove from Hew Invoices

> Account Humber Invoice Number Invoice Date Doc Type
Change Password
BE-000072360 | | | | A v

» Change Username
> Email Addresses [] BE:000072380 10100745 7I06/2013 (Wk23)  Invoice
> Add Account [[] BE:000072360 10100748 7I068/2013 (Wk23)  Invoice
Help

D BE-000072380 10100747 TI068/2013 (Wk23)  Invoice
> Customer Portal User Guide

[ eE:00 10100748 7i08/2013 (Wk23)  Invoice
> Get Adobe Reader
Logout BE.000072380 TIOE/Z013 (WK23)  Invoice
> Logout BE.000072360 10/04/2013 (WK15)  Invoice

[ BE:000072360 10041202 11/04/2013 (Wk15)  Credit Note

Amount

4827 EUR

1512 EUR

43 T4EUR

50,57 EUR

31,69 EUR

451,25 EUR

-451,25EUR

Due Date

1410612013

1410612013

1410612013

14/08/2013

1410612013

1TI0412013

18/04/2013

B EEAAEEE A

Download Selected

ooooooao
o O O o s s s L

ooooooo@

Removing

To delete items from ‘New Documents’
simple select the one you want to remove
and click ‘Remove from New Documents’.
This will mark the invoice as read and
transfer it to the ‘All Documents’ section.
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elnvoicing 1= POF Document
Language Selection
English e & csvData Fie
Documents XLS Data File
> Hew Documents Hew Documents B i oata Fie
> All Documents
Preferences / \
» Change Password < |\rwmca Humber | |Irwmce Date ‘ ‘Dnc Type )mnunt Due Date  View
All b =]
» Change Username o u
> Email Addresses [] BE:000003645 TThoice 0,00 EUR /0672013 HE E |
> Add Account [] BE:000003648 10084433 SI06/2013 (Wk23)  Invoice 0,00 EUR 12/06/2013 FE B B
Hel
gl O 10058044 1/08/2013 (Wk18)  Invoice 0,00 EUR 80572013 ] B B B B
» Customer Portal User Guide
10085481 8I05/2013 (WK19) D00 EUR 15052013
> Get Adobe Reader O g el oooad
Logout O 10072527 15/05/2013 (WK20) Invoice 0,00 EUR 22052013 B OO0 O
> Logout [] pf:ovo003s4s 10079381 22/05/2013 (WK21) Invoice 0,00 EUR 28/05/2013 | EE B B
BE:000002649 10028385 30412013 (Wk14)  Invoice D00EUR 10/04/2013 |
[] ©BE:000003648 10035821 10/04/2013 (WK15) Invoice 0,00 EUR 17/04/2013 O0Oodo
[] BE000003648 10043011 17/04/2013 (WK18) Invoice 000 EUR 24/04/2013 HFE E |
[] BE:000003648 10050581 24/04/2013 (Wk17) Invoice 0,00 EUR 1/05/2013 i O O
[ BE:000003849 09997894 80372013 (Wk10)  Invoice 0,00 EUR 13/03/2013 ] B B B B
[] BE:000003848 10005753 13/03/2013 (Wk11) Invoice 0,00 EUR 200032013 Ooo0Oogao
[] BE:000003848 10012192 20/03/2013 (Wk12) Invoice 0,00 EUR 27/03i2013 B OO0 O
[] BE:000003648 10020652 27/03/2013 (WK13) Invoice D00EUR 3/0412013 |l B B B B
[] BE:000003648 09960527 30/01/2012 (WKS)  Invoice D00EUR 610212013 |
['] BE.000003645 08967943 £i02/2013 (WK} __Invoice 0,00 FUR _13/02/2013 [0 1 1 1 s

Searching

When you need to search for a document
that you have already viewed, click on ‘All
Documents’. You will be able to search by:

eAccount number
eInvoice number
eInvoice date
eDocument type
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EIFIVGICII'Ig POF Document
Language Selection
English v CSV Data File
Documents XLS Data File
> New Doguments New Documents XML Data File
> All Documents
Preferences — e
PO Account Number Invoice Number | |Irwmce Date ‘ ‘Dnc Type | Amount Due Date
All b -~ =]
» Change Username ﬁ
> Email Addresses [] BE:000003648 - D.00EUR 5/06/2013 FE B B
> Add Account [] BE:000003649 10094433 S/08/2013 (Wk23)  Invoice 0,00 EUR 12/068/2013 B B B H
Hel
gl O 10058044 /0572013 (Wk18)  Invoice 0,00 EUR 80572013 FE A B
» Customer Portal User Guide
10085481 /052013 (Wk19) 0,00EUR 15/05/2013
> Get Adobe Reader O 0 Inveice FE E B
Logout ] 10072527 15/05/2013 (Wk20) Invoice 0,00 EUR 22/05/2013 FE B B
> Logout [] pf:ovo003s4s 10079381 22/05(2013 (Wk21) Invoice 0,00EUR 28/05/2013 F B B B
BE:000003648 10028385 30412013 (Wk14)  Invoice 0,00EUR 10/04/2013 OO0 0O
[] BE:000003648 10035821 10/04/2013 (Wk15) Invoice 0,00 EUR 17/04/2013 il O O O
[] BE:000003648 10043011 17/04i2013 (Wk18) Invoice 0,00 EUR 24/04/2013 FE B B
[] BE:000003648 10050591 24/04/2013 (Wk17) Invoice 0,00EUR 1/05/2013 i O O
[ BE:000003849 09997894 80372013 (WK10)  Invoice 0,00 EUR 13/03/2013 FE A B
[ BE:000003849 10005753 13/02/2013 (Wki1) Invoice 0,00EUR 20/03/2013 FEE B
[ BE:000003649 10013192 20/03(2013 (Wk12) Invoice 0,00 EUR 27/03/2013 FE B B
[ BE:000003649 10020652 27/03(2013 (Wk13) Invoice 0,00EUR 3/04/2013 F B B B
[ BE:000003648 09960527 30/01/2013 (WkS)  Invoice 0,00EUR 6/02/2013 OO0 0O
['] BE.000003645 08367843 £i02/2013 (WK} __Invoice 0,00 FUR _13/02/2013 [0 1 1 1 s

Sorting
You can organise your invoices by ascending
or descending order according to:

eAccount number
eInvoice number
eInvoice date
eDocument type
eAmount
ePayment due date

Click the relevant column header once for
ascending order or twice for descending
order.

eArchiving

elnvoicing enables you to store up to 26
weeks worth of billing information from the
date you registered. After 26 weeks the
oldest invoice will be deleted, so remember
to download the files you need to keep on
your system.
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elnvoicing
Language Selection

English hd
Documents

> New Documents Email Addresses

> All Documents Notification Email Addresses

Preferences
| Email Address

> Change Password

Invoice Email Addresses

> Email Addresses
~~~addaccount

Help

| Account Humber | Email Address

; Copy Invoice Email Addresses (max 5 per account)
¥ Customer PortallUser Guide

> Get Adobe Readér | Account Number | Email Address |
Logout .
C5V Email Addresses (max 5 per account)
> Logout
| Account Humber | Email Address |
Email Addresses
Via the submenu Email Addresses on Notifiication Email Address: notification Copy Invoice Email Addresses: you can enter
elnvoicing, you can manage where original emails will be send to these addresses once amaximum of 5 email addresses per account
elnvoices, copy elnvoices and csv data files new documents are posted on any of the number to which we will send a copy of the
are sent to. accounts linked to your customer user id. elnvoice PDF.
Invoice Email Addresses: this address will be CSV Email Addresses: you can enter a
used to send the original elnvoice PDF. One maximum of 5 email addresses per account
address per account number can be entered. number to which we will send a data file in

CSV format for the newly posted elnvoices.
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paid bills

List of Bills Paid or Payment Arranged INTERFACE - A A T HORTHERN

To display paid bills, select the appropriste search criteria:

= Open Eills

= Paid Bills Eeriod
erion

Status
|Processed %] | Last12 Months & | [Find] [Extend Searon|

= Display Open hams

= Balances snd Line tems
Bill Descripti Oue % Billed Amount Already Paid Status Payment Method Action
# Dispute Cases Invoice TODGO0S of 11.02.2013 11-har-2013 GEP 1,000.00 GEP 1,000.00 | Processed Other Payments/Settlements
= Selact Ascount Credit merrﬁ BO0D000 of 05032013 05-hiar-2013 - GE 1,000.00 - BE 1,000.00 | Processed Other Pawments/Settlements
Credit mer'n EOOD001 of 05032013 0F-hiar-2013 - GBP 1,000.00 - GBP 1,000.00 | Processed Other Paymenits/Settlaments
=Back To Online Billing Credit megho 8000002 of 06.03.2013 05-har-2013 - GBP 1,260.00 - GBP 1,2460.00 | Processed Other Pawments/ Settlements
| CER o 1200 EF 120000 | Frovessed | Ouher Payments/Setliements
Credit mgmo 7D00003 of D5.03.2013 D5-har-2013 - GBP 944.00 - GBP 944,00 | Processed Other Payments/Settlements
* Log Off Credit mfmo 1 of 05032013 05-har-2013 - GAP 4.00 Processed Other Paymentz/Gettlements
Credit memo 7000004 of 05.03.2013 0F-hiar-2013 - GBP 1.00 / - GBP 1.00 md Other Paymenits/Settlaments
Invoicef 7000002 of 04.02.2013 - GBP 1,260.00 ( GEBP 1,260.00 | Progess: Other Pawments/ Settlements
oF 1260 EIEFTER { other Poyments/Setliements
Invoicd 28000007 of 05.02.2013 - GBP 950.00 \ GBP 950,00 | P ed Other Payments/Settlements
Irioigk 500000 of 05.03.2013 15-htar-2013 GAP 500.00 ~SSSEAREHIT | Processed Other Payments/ Settlement s
Inum’a 10f 02.032013 03-hiar-2013 GAFP 100.00 GBP 100 Processed Other Paymenits/Settlaments
Invofze 000010 of 01.02.2013 GEP 10,000.00 GBP 5,000, Progessed Other Pawments/ Settlements
| CRS Sof 1000 SOREN00 0 |Povesced [ OWer Paymentsi Setiements
Invdice TOD0O002 of 01.02.2013 01-har-2013 GEP 10,000.00 GEP 5,100, Proceszed Other Payments/Settlements
Inice TO0000E of 01.03.2013 01-hisr-2013 GBP 10,000.00 GBP 5,500, Proceszed Other Pawments/Settlements
Infaice 7000010 of 01.03 2013 01-hiar-2013 GEP 10,000.00 GBP 10,000 Processed Other Paymenits/Settlaments
Ingroice FOD0010 of 01.02.2013 01-Nar-2013 GEP 10,000.00 GBP 10,000 Progessed Other Pawments/ Settlements
Sof 1000 SEP 000000 | Provessed  dOther Poymentsifettements 1|
Igvoice TOD0010 of 01.02.2013 ID|-NEr-ED|3 GEP 10,000.00 GEP 5,000, Proceszed Other Payments/Settlaments _ p—
Paid Invoices Download Payment Details
From the Online Billing landing page, select If you want to download the list of previously To display the details of payments that paid
ePayment to view and download your paid invoices , simply click the download an invoice simply click the already paid
account statements, or raise an invoice button. You will then be prompted to amount for the invoice you want to view.
dispute and track its progress. download the list into a CSV file.

To view the invoices that you have
previously paid, select status ‘Processed’ and
the period you wish to view, then click Find.
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Display Open ltems INTERFACE - A A T HORTHERH
= Open Bills

Paymerts & Credits Eills

= Paid Bills

Reference Reference Date Documert No. Amourt | Reference Reference Date Document Ho.

[« & iy sz s har-2013 TBOD000Z04 - Credit meame T TE0000000 T - Invoice
(3] soo000s 11-hdar-201 P e—— e |
* Balances and Line kams m ! TE-hEr2013 40000006 - Incoming payment i 08-har- 2013 TB000DO030 - Inveice
o TE-her 2013 400000007 - Incoming payment . [3) sooo00a TE-Mer2013 TE000D0034 - Invoice
» Dispute Cases 2 18-Mar-2013 140000000% - Incoming payment GBP 5,500.00 j 3000010 18-Mar-2013 1300000035 - Invoice
- - ] Mar- -
+ et Amoount T 20-0ar- 2013 0000001 - Incoming payment GEP 5.000.00 [ 7oo00es T6-NEr2013 TEOOUOO _nvore
(3] rooooog To-MEr2013 TB000DOTT - Invoice
“Back To Orline Billing [3)_rooooio To-MEr2013 TB000DO03E - Inveice
[ _7ooonin TE-Mer 2013 TE00000041 - Invoice
= Lag O (3] _soo0006 05-Nar 2013 180000003 1 - Invoice
[ _soo0007 TI-Mer2013 TB000000TE - Invoice
Total: GBP 20,760 00 Total: GBP 72,060 00
EUFR 0.00 EUR 2.500.00
Balance: GBF 51,300.00
EUF: 2,500.00 e —

Terms of use  privacy statement
Intellectus! and other property rights to tyf information cortained in this ste are held by TNT Holding B, with all rights reserved @2011

Open Items Detail View Download

You can organise your invoices by ascending To display all your open items in a If you want to download the list of open

or descending order according to: consolidated list click detail view. items , simply click the detail view button.
You will then have the options to download

* Reference in Excel or CSV.

* Reference Date

e Document number The option to Print is also available in the

*  Amount. detail view.

Click the relevant column header once for
ascending order or twice for descending
order.




viewin

balances & line items

sure wk Gas-
i i
. - Balances and Line tems INTERFACE - A A T HORTHER,
pen BlE To see the items for = particular peried, click on the corresponding smourt.
= Faid Eills Fiscal Vear :[2013 v Currency: GEP T
2 Balances
< & B ETees end) e e Harth Dehit Credit Ealznce Accumulsted Balance
2013 GBP 16,500.00
= Dispute Cases 0172012 GEP 000 GEP 0.00 GBP 16,500.00
02730 GBF .00 GBF 16,500.00 |
> Select Aocourt 03720 GBF 58,865 00 GBF 52.305.00 |
0520 ———— 0.
=Back Ta Online Billing <—E GEP 0.00 GBP 63,304
0E/20 304,
= Log Of 0972013 GBP 0.00 00 0 GBP 53,304.00
1172012 GBP 000 .00 GEP 0.00 GBP 52,204.00
122013 GBP 0.00 | | GBF 52,304.00
Total GBF 2885500 | GBF2E 20400 GEF 52.304.00
/ k Print Excel C8Y )
/ / —
Balances Detail View View/Hide Sales
Select the year you want to view the To display the items that make up any of the To view an additional column that displays
balances for. balances click the amount in the debit, credit the value of sales for each month select

or balance columns. ‘Display Sales’ from the dropdown




disputing

an invoice and tracking its progress

sure wg QL
A
List of Open Bills INTERFACE - A A T HORTHERN
= Open Bills i i}
1. Select all bills that you would like to pay:
[ Eill Dezcription e = Bill=d Amount Open Fayment Amount __Acfion
= Display Dpen tems [0 nveica 00007 ot 11.03 2013 11-var2013 GBP 1,202 40 GBF 120240
* Balances and Line kems Inwoice 7000006 of 05.03.2013 D5-Mar-2013 GBF 1,050 00 GBP 1,060.00 ( '
- Dipue Domee 01 | inwoice sona0os of 05,02 2013 0541013 GO 801 60 58P 80160 = 1
R [ | inwoice s000003 of 01.03 113 Nar-2013 GBF 10,000.00 GBF 10,000.00 =
0] | iwoice so000ta o o102 2013 o101 GBP 10,000.00 GBF 5,000.00
=Back To Online Eilling
[ | iweice 7o00002 of 0102 2013 o1-Mar2013 5BP 10,000.00 GBF 400,00
= Lag 0
D m Inwoice 7000009 of 01.03.2013 01-Mar-2013 GBF 10,000 00 GBP 4,500.00
0 | weice 7o0001a o 0102 2013 o1-Mar2013 5BP 10,000.00 GBP 10,000.00
[ | o inwoice vo00010 of 01,03 2013 012013 GBF 10,000.00 GBF 5,000.00
=
0 | weice 1t 12032012 18-ar2012 58P 5,500 00 GO 5,500.00
[ | wwice 1of 1023012 19-Mar-2012 G8F 5,500 00 5B 5,500.00
Cradit Descriptian validfram 3 Cradit Amount Avvailzble Paymert Amourd __ Actian
] [ credit memo sononos of 11022013/ [1r-verz0tz | - 58P 100.00 | - 6 10000
1 [crea meme sooooos of 0500 298 | | - 6P 5000 | = |
y A
|Belectll] [ Deselect ] [Dowyhad Selested Enties] Total Nt Payment Amount | 0BF 53,304 ﬂﬂl BP 0.00 |
y A

2. Choose Continue to chegk and confirm your payment.

Terms of use  privacy skatement

Intellectusl and other property rights to the jfformation contained in this site are held by TMT Holding B.W. with all rights reserved @2011

Select your invoice

Select ‘Open Bills’ from the menu.

Click on the ‘Action’ icon for the invoice on
which you wish to raise a dispute.




disputing

an invoice and tracking its progress

000,

sure wi G-
——
> Open Bills Enter Dispute Case 000000064 - NORTON WELLS
 Paid Bil To create a dispute case for the following document, enter the required data.
'al s

To send your inquiry, choose Send.

> Display Open ltems To return to the overview, choose Back.

> Balances and Line ltems Bill or Credit Date Amount Open

> Dispute Cases |In\:ai0§ 0000000005814080 of 12.04.2012 |1E—Msy—2313 GBF 122.80 | GBF 123.80
T

Al t
> Select Account meun

-umentation | 122.80

=>Back To Online Billing

= Log Off

Comment;

Terms of use  privacy statement
Intellectual and other property rights tff the information contained in thiz site are held by TNT Holding B.V. with all rightz rezerved @ 2011

Dispute case details

Select a reason (Cause) from the dropdown
list, and enter detailed comments in the free
text field. Please specify for which shipment
on your invoice you wish to raise a dispute.
Then click Send.




disputing

an invoice and tracking its progress

@O

sure i Lt
e
> Open Bills Confirmation for the Creation of a Dispute Case 000000064 - NORTON WELLS
Your data has been noted, and will be processed as quickly as possible,
> Paid Bills
Bill or Credit Date Amount
> Digplay Open ltems Invoice 0000000005614080 of 12.04.2012 15-May-2012 GEF 122.80

Dispute Cases Entered in this Session
Cause Amount Reference
> Dispute Cases Request for Documentation GEP 122.80

> Balances and Line ltems

> 5elect Account
>Back To Online Billing

> Log Off

Terms of use  privacy statement  terms & conditions
Intellectual and other property rights to the information contained in this site are held by TNT Holding B.. with all rights reserved @ 2011

Dispute case confirmation

You will receive a confirmation that your
dispute case has been created.

To track its progress, click on ‘Dispute Cases’
in the menu.




disputing

an invoice and tracking its progress

000

sure w
i A

List of Dispute Cases INTERFACE - A A T HORTHERH

= Open Bills
To display dispute cases, select the appropriste search criteria:
- Paid B
Paid Bl Status Period
» Display Open tem [Open | [Last 12 monthe | [Fina)
* Balan,
Cauze Status Crested On 3|

* Dispute Cases

7
TE= D Bills Amourt Disputed
D0DO0000T164E Ircw cice SO0D0OJT of 11.02.2013 | EUR 1,500.00 [ Price is not According te Quote 4 Agreement I New | 14 March 2013 12:32:17 |

=Back To Online Eilling

= Log Off

Detail View

To display the details of a dispute case, or
send a message to TNT regarding a dispute
case, click the dispute case ID of the dispute

Dispute Cases

To view all the dispute cases that you have
previously raised, select status ‘All"’ and the
period you wish to view, then click Find. To

only view disputes cases that are currently case.
open, select status ‘Open’ and the period
you wish to view, then click Find.




changing

your password

United Kingdom [change | larger text print page sitemnap contact us 0800 100 600

SERVICES SHIFFING TOOLS SUFFORT ABOUT US |p “ Search |

sure i Gas-
p—

Home / Finance login / Landing page / Password maintenance

Password Maintenance

Change Password - Change your pazsword
Cancel Reqistration - Cancel your registration for Online Biling

Back to Online Billing

Log Out

terms of use  privacy statement terms & conditions  THT Global
Intellectual and other property rights to the information contained in this site are held by TNT Holding B.V. with all rights reserved & 20058

Change password

To change your password, select ‘Password
Maintenance’ from the Online Billing landing
page.

Then select ‘Change Password’.




changing

your password

i E i United Kingdom [ change ] larger text print page sitemap contact us 0800 100 600

SERVICES SHIFFING TOOLS SUFFORT ABOUT US
sure wkd fan- |,O || Search |
———

Home / Finance login / Landing page / Password maintenance / Change password

Change Password

Fizlds marksd with © ar2 reguirsd

Existing Password*: | |

Enter a new password®: | | View password criteria

Re-enter the new password*: | |

Loq Out (—

terms of use privacy statement terms & conditions  TMT Global
Intellectual and other property rights to the information contained in this site are held by TNT Holding B.\/. with all rights reserved ® 2008

Change password

Enter your existing password, then enter
your new password twice.

Click the Save button.




cancelling

your Online Billing registration

i i i United Kingdom [ change | larger text print page sitemap contact us 0800 100 600
SERVICES SHIFFING TOOLS SUPPORT ABOUT LS
sure wke Gas- |,O || search |
————

Home / Finance login / Landing page / Password maintenance / Cancel registration

Cancel Registration

Onoe you canosl your registration. you will b= logged off the spplicstion and your acocount will be disaoled. Contact THT customer services to re-=nsble this
acoount.

Log Out

terms of use  privacy statement terms & conditions  TNT Global
Intellectual and other property rights to the information contained in thiz site are held by TNT Holding B.\. with all rights re

Cancel registration

To cancel your Online Billing registration, Once confirmed, your Online Billing user id
select ‘Password Maintenance’ from the will be automatically removed from our
Online Billing landing page. systems. It is possible that electronic Debit
notes will still be send out if the account
Then select ‘Cancel Registration’, and number is still open. To cancel electronic
confirm your cancelation. Debit notes, please contact your Local Billing

Centre for assistance.
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\__

There are a number of requirements you need to operate our Online Billing system.

Required: Web browsers

Latest version of Microsoft Internet Explorer 7 or later, and Firefox 3

To view Debit notes in PDF format

Adobe Acrobat v9.0 and Adobe Reader v8.0

To enable the download of the invoice data

Microsoft Excel 97 and above

Minimum requirements:
Windows 95, NT4, 98, Me, 2000 or XP Professional
Processor— 500 MHz
RAM — 64 Mbytes

Display 800x600 screen resolution and 16-bit colour




